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Some sections of these notes go into more detailed mathematical derivations and formulas. These
are included to support your understanding. The data-analysis procedures and example graphs are
provided so that you have a clear template to follow and to help avoid confusion when you work with
your own experimental data.
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Experiment 2

Experiment 2 - Directed motion
In the coming weeks, your main lecture will cover terminal velocity and the role of resistive forces. To help you
get a head start, this document provides a short introduction that outlines the basic concepts and includes a few
equations showing how terminal velocity depends on various parameters.
This document is meant to give you a general idea; your own predictions about parameter dependence may differ,
and your experimental results might not match the theory exactly.

TERMINAL VELOCITY

When an object falls through a fluid (air, water, glycerin, etc.), several forces are at play. When you release the
sphere, it falls toward the ground (toward the center of the Earth, to be more precise). This is due to the force of
gravity, i.e., its weight. But since it is moving through a fluid (not a vacuum), it also experiences a resistive force
that tries to slow the object down, much like friction.
So there is a downward gravitational force and upward resistive forces on the object. The resistive force depends
on the velocity of the object, so it increases as the object accelerates. The downward gravitational force, however,
remains the same. At some point, these forces balance out, making the net force zero, i.e., acceleration zero,
which means the velocity becomes constant. This constant velocity is called the terminal velocity.

Forces on a Falling Sphere
For a sphere of radius 𝑟, density 𝜌𝑠, and mass 𝑚 falling through a fluid of density 𝜌 𝑓 and viscosity 𝜂:

1. Weight (downward)
𝐹𝑔 = 𝑚𝑔 = 𝜌𝑠𝑉𝑔 (1)

where 𝑉 = 4
3𝜋𝑟

3 is the volume of the sphere.

2. Buoyant Force (upward, Archimedes’ principle)

𝐹𝑏 = 𝜌 𝑓𝑉𝑔 (2)
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3. Velocity-dependent resistive forces (drag forces, upward)
At low speeds and for small spheres, viscosity dominates and Stokes’ law applies:

𝐹𝑣 = 6𝜋𝜂𝑟𝑣 (3)

At higher speeds/turbulent flow, drag depends on velocity squared:

𝐹𝑑 = 1
2𝐶𝑑𝜌 𝑓 𝐴𝑣

2 (4)

where 𝐴 = 𝜋𝑟2 is the cross-sectional area of the sphere and 𝐶𝑑 is the drag coefficient.

For the current experiment, you may neglect this turbulent contribution and only consider the viscous force.

Condition for Terminal Velocity
At terminal velocity 𝑣𝑡 , the net force is zero:

Total downward force = Total upward force

𝐹𝑔 = 𝐹𝑏 + 𝐹𝑣 .

Substituting and rearranging gives:

𝜌𝑠𝑉𝑔 = 𝜌 𝑓𝑉𝑔 + 6𝜋𝜂𝑟𝑣𝑡
(𝜌𝑠 − 𝜌 𝑓 )𝑉𝑔

6𝜋𝑟𝜂
= 𝑣𝑡 .

Thus, Terminal velocity

𝑣𝑡 =
2 𝑟2 𝑔 (𝜌𝑠 − 𝜌 𝑓 )

9 𝜂
(5)
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Where:

𝑟 = radius of the sphere
𝑔 = acceleration due to gravity = 9.8 m/s2

𝜌𝑠 = density of the sphere
𝜌 𝑓 = density of the fluid
𝜂 = coefficient of viscosity

This experiment investigates the dependence of 𝑣𝑡 on the size of the sphere, i.e., 𝑟 , the density of the sphere, i.e.,
𝜌𝑠, and the viscosity of the fluid, i.e., 𝜂.

1. 𝑣𝑡 vs. radius 𝑟 – parabolic (∝ 𝑟2)

2. 𝑣𝑡 vs. density 𝜌𝑠 – linear (∝ (𝜌𝑠 − 𝜌 𝑓 ))

3. 𝑣𝑡 vs. viscosity 𝜂 – inverse (∝ 1/𝜂)
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Experiment 3

Experiment 3 - Random motion
In this experiment, you will look at motion on the microscopic scale, known as Brownian motion. This was
actually the first clear evidence for the existence of molecules. Robert Brown noticed that pollen grains under a
microscope seemed to “wiggle” around, which is due to water molecules constantly bumping into the pollen,
making it move randomly.
In the lab, you will replicate this idea by observing tiny silica beads suspended in water under a microscope. You
will then study how the random motion (or diffusion) of these beads depends on two things: the radius of the
bead and the viscosity of the liquid they are in.

ROOT MEAN SQUARE (RMS) DISTANCE

Consider placing a drop of ink gently on the surface of water in a test tube (to minimize convection and other
disturbances) and starting your clock. At time zero, the ink particles are all at the starting point. As time passes,
they spread out. Eventually (after many hours), the entire column of water changes color, reaching a uniform
concentration of ink particles throughout (see the figure).

Figure 1: Time evolution of ink diffusion in a still water column. Panels show the normalized concentration
𝐶/𝐶max at 0 s, 10 min, 30 min, 1 h, and 10 h ( Molecular diffusion gradually spreads the ink and is a really slow
process; in real-life examples like perfume dispersing through a room, bulk air currents (convection) are usually
the primary mixing mechanism.)

This process is called diffusion: the transfer of particles from a region of higher concentration to a region of
lower concentration. Diffusion occurs due to the underlying random, or Brownian, motion of the particles.
What would be an appropriate way to measure diffusion? Diffusion depends on time, so you need a measure that
captures how far particles spread as time passes. At first, you might think of taking the average displacement of
all the particles from the initial point. But since diffusion is a random walk, each particle has an equal chance of
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moving left or right. When all these displacements are added up, they cancel out, and the average displacement
is always close to zero. This makes the arithmetic mean a poor choice for describing diffusion.
Instead, you use the root mean square (RMS) displacement, which is a statistical mean:

1. Square each displacement (this removes the negative signs so left and right do not cancel).

2. Take the average (mean) of these squared displacements.

3. Finally, take the square root to return to distance units.

RMS

𝑟𝑟𝑚𝑠 (𝑡) =
√︂

𝑟1(𝑡)2 + 𝑟2(𝑡)2 + · · · + 𝑟𝑖 (𝑡)2 + · · · + 𝑟𝑁 (𝑡)2

𝑁
(6)

Where:

𝑟𝑖 (𝑡) = displacement of the i th particle at time t
𝑁 = total number of particles

This RMS distance gives a meaningful measure of how far particles typically wander away from their starting
point due to random motion.
For diffusive motion in two dimensions, the RMS distance in terms of the diffusion constant is given by
RMS distance in 2D

𝑟𝑟𝑚𝑠 (𝑡) =
√

4 𝐷 𝑡 (7)

Where:

𝐷 = diffusion constant
𝑡 = time

The reason for the random motion is the thermal agitation in the system. Einstein proposed that the diffusion
constant depends on the temperature of the system and on a quantity called the mobility, defined as

𝜇 =
𝑣

𝐹
(8)

which quantifies how easily an object moves under an applied force.
Einstein related diffusion to mobility through

𝐷 = 𝜇 𝑘𝐵 𝑇 , (9)

where 𝑘𝐵 is the Boltzmann constant and 𝑇 is the absolute temperature.
During random motion in a liquid, the dominant force experienced by the particle is the viscous drag, given by
Stokes’ law:

𝐹viscous = 6𝜋𝜂𝑟𝑣,

where 𝜂 is the viscosity of the fluid and 𝑟 is the radius of the particle. Therefore, the mobility is

𝜇 =
𝑣

𝐹viscous
=

1
6𝜋𝜂𝑟

. (10)

Comparing the above two equations ( Eq. 9and 10), we obtain the famous Stokes–Einstein relation:
Diffusion constant (𝐷)

𝐷 =
𝑘𝐵𝑇

6𝜋𝜂𝑟
(11)
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Where:

𝑇 = temperature
𝜂 = coefficient of viscosity
𝑟 = radius of the spherical particle

Figure 2: Shows the relationship of radius and viscosity on diffusion constant

WEEK-2 DATA ANALYSIS

The aim of this experiment is to determine how bead radius and fluid viscosity affect the diffusion constant.
Following the lab manual, you will record three videos of beads suspended in liquid and track at least 10 particles
from each video.
From the ImageJ output, you will obtain the 𝑥 and 𝑦 positions of the tracked particles. From these, you can
calculate the displacement at each time step, as follows:

Figure 3: Example excel data sheet

Steps
( refer to the example Excel sheet Fig. 3 )

1. Define the Initial Position
At 𝑡 = 0 s (first frame), define each particle’s initial position

(𝑥0, 𝑦0)
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as the origin for that particle’s motion. Therefore, the squared displacement values are

𝑅2 = 0

for the first row of data for all particles (for example: D3, G3, . . . ,AE3).

2. Compute 𝑅2 for Each Particle
For each time step, calculate the squared radial displacement relative to the initial position:

𝑅2(𝑡) = (𝑥 − 𝑥0)2 + (𝑦 − 𝑦0)2.

Example (Particle 1):
In Excel cell D4, enter:

=(B4-B$3)^2 + (C4-C$3)^2

The dollar signs ($) lock the reference to the initial position row (𝑡 = 0), ensuring that 𝑥0 and 𝑦0 remain
fixed when the formula is copied.
Drag this formula down to fill all time points (rows). Repeat the same process for each particle:

• Particle 2 → Column G
• Particle 3 → Column J
• etc.

(Note: Exact cell references may differ depending on how your Excel worksheet is arranged.)

3. Compute the Mean-Squared Displacement
At each time step, calculate the mean of all squared displacements:

𝑅2
rms(𝑡) =

𝑅2
1 + 𝑅2

2 + · · · + 𝑅2
10

10
.

In Excel, use the AVERAGE function. For example, in the summary column (cell AF4 in the Fig. 3) enter:

=AVERAGE(D4, G4, J4, ...)

Taking the square root of this quantity gives 𝑅rms.

4. Plot
Create a plot of:

• 𝑥-axis: Time 𝑡
• 𝑦-axis: 𝑅2

rms(𝑡)

Add a linear trendline to the data and display its equation.

5. Determine the Diffusion Rate
The slope of the trendline corresponds to the diffusion behavior. For Brownian motion analysis, the
diffusion coefficient 𝐷 is obtained from:

𝐷 =
slope

4
.
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Figure 4: 𝑅2
𝑟𝑚𝑠 vs 𝑡 graph with linear trendline.

Example conversion of 𝐷 to SI units

From the graph Fig. 4,
𝐷 =

0.8812
4

= 0.2203 pixel2/s.

Using the spatial calibration,

1 𝜇m = 5.179 pixels ⇒ 1 pixel =
1

5.179
𝜇m,

so

1 pixel2 =

(
1

5.179

)2
𝜇m2 =

1
5.1792 𝜇m2 ≈ 1

26.822
𝜇m2 ≈ 0.0373 𝜇m2.

Therefore,
𝐷 = 0.2203 pixel2/s = 0.2203 × 1

5.1792 𝜇m2/s ≈ 8.2 × 10−3 𝜇m2/s.

You should repeat the calculation for all the videos, and finally plot the parameter vs. diffusion constant graph.
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Experiment 4

Experiment 4 - Random+Directed motion
In the previous experiment, you studied Brownian motion, the random motion of microscopic beads suspended
in water, and observed how the radius of the bead and the viscosity of the fluid influence the diffusion constant.
In that case, the motion was driven entirely by thermal agitation, so the particles had no preferred direction of
movement.
In this experiment, you will perform a similar observation, but now the microscope is tilted, introducing a
gravitational force component. This adds a directed force that tends to pull the beads in one direction.
Random motion (Brownian motion) causes particles to spread out in all directions.
Directed motion (due to gravity) causes particles to drift preferentially in one direction.
The motion you observe will be a combination of these two effects. The key objective of this experiment is to
determine which type of motion dominates under different conditions, and specifically, how this depends on bead
size. Smaller beads are strongly influenced by random motion, while larger beads are more affected by gravity.
To distinguish between these behaviors quantitatively, you will analyze the bead trajectories using log–log plots of
mean-squared displacement versus time, which allows you to identify whether the motion is primarily diffusive,
primarily directed, or a mixture of both.

Purely Random (Diffusive) Motion
For Brownian motion in two dimensions, Einstein showed:

𝑅2
𝑟𝑚𝑠 = ⟨𝑟2(𝑡)⟩ = 4𝐷𝑡,

where 𝐷 is the diffusion constant. This is a linear relationship in time.
Taking the logarithm of both sides:

log(𝑅2
𝑟𝑚𝑠) = log(4𝐷) + log(𝑡).

If you plot log(𝑅2
𝑟𝑚𝑠) vs. log(𝑡), the graph will be of the form 𝑦 = 𝑚𝑥 + 𝑏 with slope 𝑚 = 1.

Diffusion-dominated motion: slope ≈ 1.

Purely Directed Motion
If a constant force acts on the particle, it moves with a constant velocity 𝑣 (even though a constant force is present,
microscopic particles in water do not accelerate; viscous drag is so strong that they reach terminal velocity almost
instantly, so their displacement grows linearly in time rather than quadratically):

𝑟 (𝑡) = 𝑣𝑡 ⇒ 𝑅2
𝑟𝑚𝑠 = 𝑣2𝑡2.

Taking the logarithm:
log(𝑅2

𝑟𝑚𝑠) = log(𝑣2) + 2 log(𝑡),
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Figure 5: Graphs for the case with only diffusion.

which again matches 𝑦 = 𝑚𝑥 + 𝑏, but now with slope:

Directed motion: slope ≈ 2.

Figure 6: Graphs for the case with only directed motion.

Mixed Motion
In many biological and experimental systems, both random and directed motion occur. In these cases:

⟨𝑟2(𝑡)⟩ ∝ 𝑡𝛼,

with 1 < 𝛼 < 2. The value of 𝛼 indicates the balance between Brownian motion and directed drift.
If both effects are about equal, the slope will be around 1.5. In this experiment:

Figure 7: Graphs for the case of equal contribution of both motions.
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• 2 𝜇m beads are more affected by Brownian motion, so you expect their slope to be closer to 1 .

• 5 𝜇m beads feel the directed motion more, so their slope should be closer to 2 .

The exact value depends on how much the microscope is tilted and how well the tracking is done.

Week 2 - Data Analysis

Figure 8: Example excel data sheet

While choosing vesicles to track, inspect the data carefully. If you observe any abrupt or unrealistic jumps in
the measured 𝑥 or 𝑦 positions (which typically indicate tracking errors), that particle should be discarded and
replaced with a different particle.
Only particle exhibiting continuous motion should be included in the analysis ( you should look at the imageJ
output image showing paths and labels, and pick the particles wisely).

Excel Analysis Steps
( refer to the example Excel sheet, Fig. 8 )

1. Convert Frame Number to Time
Change the Frame column (A) to Time by typing in 0, 0.033, and dragging down to all the cells. This
corresponds to the frame interval

Δ𝑡 = 0.033 s.

2. Define the Origin
At 𝑡 = 0 s (first frame), define each particle’s initial position as the origin

(𝑥0, 𝑦0).

Therefore,
𝑅2 = 0

for the first row of all particles (for example: D3, G3, . . . ).

3. Compute 𝑅2 for Each Particle
The squared displacement for each particle is defined as

𝑅2(𝑡) = (𝑥 − 𝑥0)2 + (𝑦 − 𝑦0)2.

Example (Particle 1):

In cell D4, enter:
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=(B4-B$3)^2 + (C4-C$3)^2

The dollar sign ($) locks the reference to the initial position at 𝑡 = 0 so it does not change when the formula
is copied.
Drag this formula down to fill all time points (rows), and repeat the calculation for all tracked particles.
(Note: Exact cell references for you may vary depending on the Excel layout.)

4. Compute the Mean-Squared Displacement
In the column following 𝑅2

10 (for example AF4), calculate the average square displacement:

𝑅2
rms(𝑡) =

𝑅2
1 + 𝑅2

2 + · · · + 𝑅2
10

10
.

In Excel, use:

=AVERAGE(D4, G4, J4, ..., AE4)

5. Compute the RMS Displacement
To obtain the RMS displacement,

𝑅𝑟𝑚𝑠 (𝑡) =
√︃
𝑅2

rms(𝑡).

In Excel, for example in cell AG4, enter:

=SQRT(AF4).

6. Compute the Natural Logarithms
Excel’s natural logarithm function is LN().

• For ln(𝑡) (cell AH4), use:
=LN(A4).

• For ln(𝑅2) (cell AI4), use:
=LN(AF4).

7. Plot the Required Graphs
For each video, produce the following three plots:

(a) 𝑅 vs. 𝑡
(b) 𝑅2

rms vs. 𝑡
(c) ln(𝑅2

rms) vs. ln(𝑡)

The third plot must include a linear trendline and the displayed equation.
Refer to the example graphs:
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Figure 9: Graphs for a 5 𝜇m silica bead in water. The log–log plot has a slope of 1.93, indicating that the motion
is dominated by gravity.
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Experiment 5

Experiment 5 - Motion in Living Cell
To calculate the rate of ATP hydrolysis (𝑅) and the coefficient of viscosity (𝜂), you will use the average radius
(𝑟) and average speed (𝑣) obtained from ImageJ. With these values, you can proceed as follows:

Figure 10: Schematic of a vesicle of radius 𝑟 moving with constant velocity 𝑣 through a viscous medium. The
motor force is balanced by the viscous drag; therefore, the vesicle is traveling with a constant speed.

Work and Power
Some definitions:
Work done on an object by a force F causing a displacement d is given by

𝑊 = F · d = |F| |d| cos 𝜃, (12)

where 𝜃 is the angle between the force and displacement. In your case the viscous drag force is opposite to the
direction of motion (𝜃 = 180◦), so the work done by the viscous force is negative. In terms of magnitudes you
will use

|𝑊 | = |F| |d|.

Power is defined as the rate of doing work:
𝑃 =

𝑊

𝑡
. (13)

Useful biological numbers:

• Average size of a kinesin motor “step”: 𝑠kin ≈ 8 nm (along a tubulin dimer).

• Average size of a myosin motor “step”: 𝑠myo ≈ 10 nm (along an actin filament).

• One “step” ≈ one ATP hydrolysis cycle. The energy released per mole of ATP is about 𝐸mol = 23 kJ/mol.
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• To get the energy per ATP molecule in SI units (J), use

𝐸 =
𝐸mol
𝑁𝐴

,

where 𝑁𝐴 is Avogadro’s number.

• The efficiency of the motor protein is approximately 𝑒 = 60% = 0.6.

The efficiency is defined as

efficiency = 𝑒 =
𝑊produced

𝐸consumed
=

𝑃produced

𝑃consumed
. (14)

The total work consumed comes from ATP hydrolysis. If 𝑁 is the number of ATP cycles in a time 𝑡 and 𝐸 is the
energy released in a single ATP cycle (in J per molecule), then

𝑃consumed =
𝑊consumed

𝑡
=

𝑁𝐸

𝑡
= 𝑅𝐸 , (15)

where
𝑅 =

𝑁

𝑡

is the rate of ATP hydrolysis (ATP molecules per second).
Since the vesicle is moving with (approximately) constant velocity, the net force is zero: the forward motor force
equals the viscous drag. The mechanical power produced by the vesicle (via the motor) is then

𝑃produced =
𝑊produced

𝑡
=

𝐹𝑑

𝑡
= 𝐹𝑣, (16)

where 𝐹 is the magnitude of the force exerted by the motor on the vesicle and 𝑣 is the speed.

Rate of ATP hydrolysis 𝑅 from the average velocity 𝑣

The average velocity is given by
𝑣 =

𝑑

𝑡
. (17)

Here 𝑑 is the total displacement in time 𝑡. If 𝑁 is the number of ATP cycles and 𝑠 is the step size of the motor,
then the total distance is 𝑑 = 𝑁𝑠. Therefore

𝑣 =
𝑁𝑠

𝑡
= 𝑅𝑠. (18)

Thus the rate of ATP hydrolysis is
𝑅 =

𝑣

𝑠
. (19)

Important: In your calculations, use SI units:

• Convert the step size from nm to m (1 nm = 10−9 m).

• Convert 𝑣 from 𝜇m/s (or similar) to m/s.

Coefficient of viscosity 𝜂 from average radius 𝑟
The viscous drag force acting on a slowly moving spherical particle in a fluid is given by Stokes’ law:

𝐹viscous = 6𝜋𝜂𝑟𝑣, (20)

where
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• 𝑟 is the average radius of the vesicle (from ImageJ),

• 𝑣 is the terminal (steady) velocity from your tracking,

• 𝜂 is the dynamic viscosity of the cytosol.

You can now relate this force to the motor energetics using the efficiency. Rearranging the efficiency relation,

𝑒 × 𝑃consumed = 𝑃produced. (21)

Substituting the expressions for 𝑃consumed and 𝑃produced,

𝑒 × 𝑅 × 𝐸 = 𝐹𝑣. (22)

Therefore the magnitude of the force is
𝐹 =

𝑒𝑅𝐸

𝑣
. (23)

Using Stokes’ law, the coefficient of viscosity is

𝜂 =
𝐹

6𝜋𝑟𝑣

=
𝑒𝑅𝐸/𝑣
6𝜋𝑟𝑣

=
𝑒𝑅𝐸

6𝜋𝑟𝑣2

=
𝑒(𝑣/𝑠)𝐸
6𝜋𝑟𝑣2

=
𝑒𝐸

6𝜋𝑟𝑣𝑠
. (24)

Again, use SI units for all quantities:

• 𝑟 in meters,

• 𝑣 in meters per second,

• 𝑠 in meters,

• 𝐸 in joules per ATP molecule.

In this experiment, it is not possible to distinguish between kinesin and myosin motors, so you will compute 𝜂 for
both:

• Kinesin: 𝑠 = 8 nm,

• Myosin: 𝑠 = 10 nm.

The calculated values can then be compared with the viscosity of water,

𝜂water ≈ 8.6 × 10−4 Pa · s.

A significantly larger effective viscosity suggests that the cytosol behaves as a more crowded and structured
medium than pure water.

WEEK 1 - ANALYZING VESICLE MOTION

As a group, select 10 vesicles that clearly exhibit linear (directed) motion (not random Brownian motion).
Velocity data will be obtained using the Manual Tracking plugin in ImageJ.
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Reducing the Number of Frames
The original video is 5 seconds long and recorded at 30 frames per second (fps), giving a total of

150 frames.

Tracking every frame would require 150 clicks per vesicle. To simplify the procedure, you will track every third
frame instead (or You may consider recording the longer video at low fps).

ImageJ Procedure
1. Open the AVI video file in ImageJ.

2. Navigate to:
Image → Stacks → Tools → Make Substack

3. In the dialog box, enter:
1 − 150 − 3

This selects frames starting at frame 1, ending at frame 150, with a step size of 3. The resulting reduced
stack will contain:

150
3

= 50 frames.

4. Run:
Plugins → Tracking → Manual Tracking

on this reduced image stack.

Time Step Calculation
The original frame interval is:

Δ𝑡original =
1

30
s ≈ 0.03333 s.

Since you are tracking every third frame, the effective time step becomes:

Δ𝑡 = 3 × Δ𝑡original = 3 × 0.03333 s ≈ 0.0999 s.

Calibration
In the Manual Tracking plugin:

• Keep the x/y spatial calibration set to 1.

• All distance data will therefore be recorded in pixels.

Conversion from pixels to meters will be performed later during the Excel data analysis stage.

WEEK 2 - DATA ANALYSIS

Now that you have the data, do the following:

1. Combine Velocities
Put the velocity values for all vesicles into a single column. Remove any entries equal to −1 or 0.
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2. Visualize
Plot a histogram of velocities and include it in your report.

3. Average Speed
Compute the average velocity of the cleaned list. This average will be your 𝑣 for the calculations.

4. Average Radius
Average the area measurements of the tracked vesicles, then convert the mean area 𝐴̄ to a radius using

𝑟 =

√︄
𝐴̄

𝜋
.

5. Convert to SI Units
Convert 𝑣 from pixels/s (or 𝜇m/s) to m/s, and 𝑟 from pixels (or 𝜇m) to meters.
The scale factor is

1 𝜇m = 5.179 pixels ⇒ 1 pixel ≈ 0.193 𝜇m.

Example Calculation
Suppose the values for 𝑣 and 𝑟 are as follows (values are just an example):

𝑣 = 2.31 pixels/s, 𝑟 = 3.29 pixels,

and the scale
1 𝜇m = 5.179 pixels ⇒ 1 pixel = 0.193 𝜇m,

and using
𝑒 = 0.6, 𝐸mol = 23 kJ/mol = 23,000 J/mol, 𝑁𝐴 = 6.022 × 1023,

𝐸 =
23,000

6.022 × 1023 ≈ 3.82 × 10−20 J,

step sizes
kinesin: 𝑠 = 8 nm = 8 × 10−9 m, myosin: 𝑠 = 10 nm = 1.0 × 10−8 m,

you proceed as follows.
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1) Convert to SI

𝑟 = 3.29 × 0.193 𝜇m = 0.635 𝜇m = 0.635 × 10−6 m = 6.35 × 10−7 m,

𝑣 = 2.31 × 0.193 𝜇m/s = 4.46 × 10−7 m/s.

2) Rate of ATP Hydrolysis 𝑅 (from 𝑣 = 𝑅𝑠)

Kinesin (8 nm):

𝑅 =
𝑣

𝑠
=

4.46 × 10−7

8 × 10−9 ≈ 55.6 s−1.

Myosin (10 nm):

𝑅 =
4.46 × 10−7

1.0 × 10−8 ≈ 44.6 s−1.

3) Coefficient of Viscosity 𝜂

Use
𝜂 =

𝑒𝐸

6𝜋𝑟𝑣𝑠
.

Kinesin (8 nm):

𝜂 ≈ 0.6 × 3.82 × 10−20

6𝜋 × (6.35 × 10−7) × (4.46 × 10−7) × (8 × 10−9)
≈ 0.54 Pa · s.

Myosin (10 nm):
𝜂 ≈ 0.43 Pa · s.

4) Compare to Water

Compare these values with
𝜂water ≈ 8.6 × 10−4 Pa · s.

If your effective viscosity is larger than that of water, this suggests that the cytosol behaves like a thicker, more
crowded medium than pure water, which is realistic for a living cell.
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